M KaozhengPro
I:I'l..\ Hg% Hité,ﬁ

§¥=Fs

7 B pe a2 AR AR B e A
T)’J’%HJJ ERBIE R E B

www.kaozhengpro.com




The safer , easier way to help you pass any IT exams.

Exam . [7-604

Title . Using Microsoft Office
Outlook 2007

Version : Demo

1/14



The safer , easier way to help you pass any IT exams.

1.Mark works as a System Analyst for Blue Well Inc. He uses Microsoft Outlook for messaging and e-
mailing. MS Outlook has been configured to use an Exchange account. He wants to send a meeting
request to the employees of his department. He uses a distribution list named colleagues to send the
meeting request. However he wants to remove the name of Mr. James Thompson from the recipient's list.
Choose and reorder the required steps that he will take to accomplish the task. Select an item from the
right pane. Click button to move the selected item to the left pane. Click button to move the item back to
the right pane. Click and buttons to sort the list if required.

Correct steps Choose from here

jﬂ Type the distribution list name.
Click the envelope icon on the left.

Click on the Scheduling tab.
jﬂ Click the plus icon on the left.
Click the drop-down list on the laft.
Create the meeting request.

Select the Don't send meeting to this attendee option.
Click the asterisk icon on the left,

3 > < >
Answer:

Co}rect steps Choose from here

Create the meeting reguest. JJ Click the drop-down list on the left.

Type the distribution list name. Click the asterisk icon on the left.

Click on the Scheduling tab.

Click the plus icon on the left. JJ
Click the envelope icon an the left.

Select the Don't send meeting to this attendee option.

2.David works as a Support Analyst for White Well Inc. He uses Microsoft Outlook for messaging and e-
mailing. MS Outlook has been configured to use an IMAP account. He wants to print the calendar that
comprises the details of a single month. He wants to ensure that the calendar acquires the following
properties:

1. Inits layout it prints two pages.

2. It prints the details from 9 A .M. to 5 P.M.

3. The paper source of the paper in the Manual Paper Feed.

4. Orientation landscape.

5. Reverse the position of the right and left section of the header and footer so that the information in the
left section on an even page is printed in the right section on an odd page.

6. The size is sheet booklet.

What actions will he take in the Page Setup dialog box to accomplish the task.?
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Fﬁqe Setup: Daily Style E3

Style mame:  Daily Skyle

Farmatk I Paper I Header /[Foater I

— Preview:
_— ([}
O —
— Options —Fonks
Layouk: |1 page/day ﬂ Date headings
24 pt. Tah Font
Include: v TaskPad I pt. anoma
v Mates area (hlank) Appoinkments
v Motes area (lined) IE‘ pt. Tahoma Font
Print Fram: |5 A k. i
Print to: g P - ~Shading
[v Print using gray shading

Cancel | 0]%4 | PrintPreview | Print

Answer:

Page Setup: Daily Style

Skvle name: IDaiI\,.r Skvle
Farmat I Paper I Header/Fooker I
Header:
IB pt. Times Mew Roman Fant
Fooker:
IB pt. Tahama Fant
[User Mame] | [Page #] [Date Printed]
&= E]e
[v Reverse on even pages
Cancel ] 4 PrintPreview Print
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3.You work as a Security Officer for ABC Inc. You use Microsoft Outlook 2007 for messaging and e-
mailing. MS Outlook has been configured to use the Exchange account of the company. You compose an
e-mail that describes the security policies of the company. You send the e-mail to the CEO of the company.
However the message will not be received and you receive an e-mail message "l did not get the
message" from the CEO. You want to send the e-mail again to the CEO. Choose and reorder the required
steps to accomplish the task.

Cohect steps Choose from here
jﬂ Click the Send button,
Click the Resend This Message option.
The message window appears.
jﬂ Double-click a message that a user wants to resend.
In the Mail pane, click the Sent Items folder.
Click the Forward option.

Click the Other Actions option.
Click the Recall This Message option.

< b4 < b4
Answer:
Corrgct steps Choose from here
In the Mail pane, click the Sent Items folder. JJ Click the Forward option.
Double-click a message that a user wants to resend. Click the Recall This Message option.
The message window appears.
Click the Other Actions option. JJ

Click the Resend This Message option.
Click the Send button.

4.You use Microsoft Outlook 2007 for messaging and e-mailing. MS Outlook has been configured to use
an IMAP account. You receive various e-mail messages.
You want to ensure that Outlook prompts you the following message before exiting the Outlook:

Microsoft Office Dutiook

E E Are yiou sure you want to permanenth: delete all the ktems and subfolders in the “Deleted Ttems” folder?

No |

If you press the Yes button, all the contents of the Deleted Items folder will be deleted. If you press the No
button, all the contents of the Deleted Items folder will not be deleted.

Which of the following actions will you take to accomplish the task?

A. Change the auto archive settings of Outlook.

B. Change the send/receive settings of Outlook.

C. Change the message handling settings of Outlook.

D. Change the general settings of Outlook.

Answer: D

5.You work as a System Analyst for White Well Inc. You use Microsoft Outlook for messaging and
e-mailing. MS Outlook has been configured to use a POP3 account. You want to achieve the following
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goals:

1. View the first three lines of the messages in the main Outlook window so that you can scan the
messages and preview their contents without opening them along with the sender's name and the subject
line.

» Saarchin= Inbox Find How  Clas Opltions = ;

Bt O /0lFrom | Subject Receved|Sze (5.0

& zale i the penacks setivty irvibeed in 2alng products of SeRAce in Felurh For monhey oF b

othes compersation. humm&wﬂhdumﬂm[t] t-“

Thea “deal i chosed™, means the oushomes has corsanbed to oduck 0. [

B Deepika.. Hello Fri9/. ZKB J'
Halls waahits up Sanad the business afsipniments Presenalsons <ends

£)  Despha... hdshd Fi9fl... 208 J

&8 Denpdas ... hello Frd/l... 2¥B i

P N Tl i 111 LB | T P A e POy - TP R~ o P B

2. Display a row at the top of a table for entering new items.
3. Hide the divider information between the preview pane and item list.
What actions will you perform in the given dialog box to accomplish the task?

othersettmgs @R

—Zolul.a headings

% ()4 |

Font IB pt. Tahoma v Automatic column sizing

Cancel |
—Raws
- v Allowy in-cell editing
& pt. Tahoma
w I F I Show "new item” Fow

— AUboPreview

i's" Preview all ikems
Fant IE! pt. Tahoma
i Preview unread items

i Mo AutoPreview

—iarid lines
iarid line style: IDashes j Prewview: I:I
crid line color I j [w Shade group headings

—Preview Pang

v show Preview Pane

[ Hide header information

Answer:
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Other Settings

— Column headings

Faont IB pk. Tahama

Ok

[v Aukomatic column sizing

_ ok |
Cancel |

—Rows
- v Allowve in-cell editing
& pk. Tahoma
Font | I 2 v Show "new item" row
— AutoPreview

Font IB pt. Tahoma

i Preview all items
%" Preview unread items
i Mo AukoPreview

—arid lines

arid line skwle: IDashes

Ll Lo

arid line color; I

[w shade group headings

—Preview Pane

[v Show Preview Pane

v Hide header infarmation

6.You work as an Office Assistant for PHD Inc. You use Microsoft Outlook 2007 for messaging and e-
mailing. MS Outlook has been configured to use an Exchange account. You work with different Outlook
data files and e-mail accounts. You want to create a new e-mail profile named Outlook12 to store
information about the user name display name e-mail server name and Internet service provider (ISP).
Choose and reorder the required steps to accomplish the task.

Choose from here

Correct steps

¢ >

Jﬂ The Add New E-Mail Account dialog box appears.
Type a name for the profile, and then click the OK button.
Click the Add button.
Jﬂ Click the Mext button.
Click the Show Profiles button,
Click the Finish button.
Specify the filed values or select the Manually configure se
In the Control Panel window, click the Mail icon.
In the Control Panel window, click the User Accounts icon.
Click Control Panel,
Click the Start button.
Click the Data Files button.
Specify the field values, Click the Mext button.

< >

Answer:
forrect steps

Choose from here

Click the Start button,

Click Control Panel.

In the Control Panel window, click the Mail icon.

Click the Show Profiles button,

Click the Add button,

Type a name for the profile, and then click the OK button.
The Add New E-Mail Account dialog box appears.

Specify the filed values or select the Manually configure se
Click the Mext button.

Specify the field values. Click the Next button.

Click the Finish button.

JJ In the Control Panel windaw, click the User sccounts icon.

Click the Data Files button,
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7.You use Microsoft Outlook 2007 for messaging and e-mailing. MS Outlook has been configured to use
an IMAP account. You receive different e-mails and other e-mail items. You want to see a summary of
appointments a list of tasks and total number of e-mail messages in the Inbox folder. You have to make
Outlook Today the default page of the Outlook screen. The Outlook Today page provides a preview of a
day. Choose and reorder the required steps to accomplish this.

Chrrect steps Choose from here
jﬂ Click the Save Changes button.
Click the Outlook Today icon on the Reading Pane.
Select the When starting, go directly to Qutlook Today ch
jﬂ Click the Customize Outlook Today button.
Click on the Tools menu.
Click the Rules & alerts icon on the Navigation Pane.
Click the Outlook Today icon on the Mavigation Pane.
Select the Organize option.

S > S ¥
Answer:

Correct steps Choose from here

Click the Outlook Today icon on the Mavigation Pane. JJ Click the Outlook Today icon on the Reading Pane.

Click the Cudsfomize Outlook Today button. Click on the Toals menu.

Select the When starting, go directly to Outlook Today ch

Click the Rules & Alerts icon on the Navigation Pane.
Click the Save Changes button. JJ Select the Organize option.
< > < >

8.You are creating an appointment. The appointment comprises some private information. You want the
appointment to repeat its work on a daily schedule. You also want to ensure that the start time and the end
time are June 12 2008 and June 13 2008 respectively. To achieve the desired result you have to click an
option in the Options group. Mark the option in the image to accomplish the task.

hhnw A [l Busy - O Q ﬂ@ i Private

¥ High Importance

» i . i - ecurrence Time Categorize
2 Reminder: 15 minutes L o L Lo Importance
Cptions F]
Answer:
Lahu:m'u' &st [l Busy - {ﬁl Q 'ﬁlg* —‘1] Frlmte
- Lz ¥ High Importance
i3 i . i -« Recurrence| Time Categoarize
S Reminder: 15 minutes o 7t ¥ LowImporance
Qptions T

9 .You use Microsoft Outlook 2007 for messaging and e-mailing. MS Outlook has been configured to use
an IMAP account. You want to ensure that Outlook stores all the e-mails and post items into the Personl

folder. The folder is located under the Quarantine folder. Which of the following actions will you take to
accomplish the task?
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A. Create a Search Folder.
B. Customize the To-Do Bar.
C. Create a Contact.

D. Create a mail folder.
Answer: D

10.You work as a System Analyst for Blue Well Inc. You use Microsoft Outlook 2007's calendar for
scheduling events and other Outlook items. MS Outlook has been configured to use an IMAP account.
You want to share the information of the calendar to other users. However, you want the other users to
view and share the calendar information in the Overlay mode. Which of the following actions will you take
to accomplish the task?

A. Use the Share My Calendar option.

B. Open a shared calendar.

C. Publish the calendar.

D. Send the calendar via an e-mail.

Answer: D

11.You are composing an e-mail in Microsoft Outlook 2007. In Microsoft Outlook 2007 the Information
Bar provides information about each e-mail. You have an image of the main window of Outlook
2008. Mark the area which represents the Information Bar.

T Kl faf Wiew o Iools Adsone  Hslp
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Mail % « || A Drafts T ¢ P = Thiz item cannot b
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- Inbaone 4 @ deepiks Hong G4 KB
L& Wnread Mail - wuilse e (q'1]
3 St e ki
PAsil Folders 3
E AN Wil Rems *
= 2 Personsl Folders
fa) Creleted Mems
. Dvatts 1]
} b
@ Jank E-mail 1] |
L Ot | i
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# LD Search Fobders
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B,_I Cortacts
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Answer:
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12.Mark works as a Technical Assistant for Blue Well Inc. He uses Microsoft Outlook 2007 for e-mailing
and organizing information. MS Outlook has been configured to use a POP3 account. He wants to
categorize the contact of the Director of the company by using the green color category.

By using the color category he can easily and quickly identify the contact.

He clicks on the Tools menu and selects an option from the list. Mark the option to accomplish the task.

Toaols |

Send/Receive 3

Instant Search 3

[ address Book.,  Ctrl+Shift+B

“f Crganize
Mailbox Cleanup...

@ Empty "Deleted Tterns"” Folder
Forms b
Macro 3
Account Settings...

Trust Center...
Customize...
Optians..

E-miail 5can Properties,.,

Scan forWiruses..,

Answer:
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\+3

end/Receive 3
Instant Search [
@ Address Book..,  Ctrl+5hift+B
‘%’g Qrganize
Mailbox Cleanup...
@ Empty "Deleted Tterms” Folder
Forms 3
Macro 3

Account Settings...
Trust Center...
Customize...

Dptions...

E-rnail 5can Properties...

Scan forWirlses,,

13.David works as a Support Analyst for White Well Inc. He uses Microsoft Outlook for messaging and
e-mailing. MS Outlook has been configured to use an IMAP account. He works in the Message view of the
Inbox folder. He wants to change the view of e-mails so that they appear as shown in the following image:

Lo
b‘)Frﬂm: deeplka |4 R=mi)

-
fiMonday June 02, 2008 120 P fitem)
=) Created: Monday, June 02, 2008 %06 PM [1 ftem) 4
=l Created: Monday, une 02, 2008 5:15 PM [1stem] -
=) Createn: Tuesday, June 03, 2008 12:56 PM (1 item) -
£l Fromo deepika srvastavs (2 itemas) :.
=) Frome fgeDfg.com [1 tem) :,
=] Created: Sunday, March 15, 2003 11:05 A [1 item) }
) subject: hella (L item) .
=) From: garima agaraal gm [garm@oolors.comj (L item) 9
=) Ceeated: Sunday, March 15, 2003 11:03 AM {1 item) ':
H Subject meeting (1 item) £
L brgm: mieolorcom (o) :

L T T e

To accomplish the given task, he has to group the e-mail items by using the Group By dialog box. What
actions will he take to group the e-mail items as shown in the given image?
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Group By E |

[ Aukomatically group according ko arrangement Cil |
Group items by
| Do not archive w| 1 Ascending Cancel
[ Show field in view f+ Descending Clear All
Then by
|Flag status v| 7 Ascending
f"' .
I Show figld in wiew ** Descending
Then by
|DL|E by j ™ Ascending
W Show Field in view [+ Descending
Then by
" oo ﬂ ) ascending
| Show field in views £+ Descending
Select available fields From: Expand/collapse defaulks:
IFrequentIy-used Fields j I.ﬁ.s last viewwed j
Answer:
Group By ﬂ |
[ %tumatically group according Eo arrangement Ik
Graup items by
" From ﬂ ' ascending Cancel
W Show Field in view I Descending Clear All
Then by
" Created j s ascending
J:"_" .
Iv shiow Field in view + Descending
Then by
| Subject ﬂ i+ Ascending
[v Show Field in view ™" Descending
Then by
" none j % | dscending
IV | Show Field in wview " Descending
Select available fields from: Expand|collapse defaults:
IFrequentIy-used figlds j I.ﬁ.s last wigwed j

14.Sam works as a Technical Assistant for Blue Well Inc. He uses Microsoft Outlook 2007 for messaging
and e-mailing. MS Outlook has been configured to use a POP3 account. The Inbox folder of Outlook
contains some confidential and personal e-mails of Sam. He wants to exclude all the e-mails that are
located in the Inbox and contains "hello” word in the subject field or message body.
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Which of the following actions will you take to accomplish the task?
A. Use Favorite Folders Pane.

B. Use RSS Feeds.

C. Run Instant Search.

D. Create a Search Folder.

Answer: C

15.Mark works as a Support Analyst for Soft Well Inc. He uses Microsoft Outlook 2007 for messaging and
e-mailing. MS Outlook has been configured to use an IMAP account. Whenever Mark sends an e-mail,
recipients of the e-mail see only a part of the name, i.e. "Mark". He wants to ensure that the recipients of
an e-mail see their full name, i.e. "Mark Smith" in the Information Bar of the e-mail. Which of the following
actions will he take to accomplish the task?

A. Edit the Account Settings.

B. Create a new e-mail account with the name "Mark Smith".

C. In the From field, type the name "Mark Smith".

D. Add the Quick Part that contains the full name of Mark.

Answer: A

16.You are composing an e-mail. The e-mail comprises some confidential information. Now you want to
ensure that the start date of the e-mail will be June 12, 2008 and due date will be June 13, 2008.
Which of the following actions will you take to accomplish the task?

A. Use RSS Feeds

B. Use Follow Up

C. Use Reading Pane

D. Use Navigation Pane

Answer: B

17.David works as a Support Analyst for White Well Inc. He uses address books of Microsoft Outlook
2007 to save the address lists. MS Outlook has been configured to use an IMAP account. David is
searching an e-mail address of an employee. He wants to ensure that Outlook finds all the e-mail
addresses that are not in a local address book or a corporate-wide directory. Which of the following types
of address books will he use to accomplish the task?

A. Internet directory services (LDAP)

B. Outlook Address Book

C. Third Party Address Books

D. Global Address List

Answer: A

18.David works as a System Analyst for Blue Well Inc. He uses calendar of Microsoft Outlook 2007 for
scheduling events and meetings. MS Outlook has been configured to use an Exchange account. The
calendar is scheduled to use the USA holidays. The company decides to remove the birthday holidays of
Martin Luther King and Lincoln from the annual events schedule of the company so that these days will
not be treated as holidays. David wants to update the calendar schedule according to the new schedule.
Which of the following actions will he take to accomplish the task?
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A. Delete the holidays by using the Customize Current View option of the Current View list.
B. Remove the holidays by switching the view to the Annual Events view.

C. Modify the view of the calendar by using the Define Views option.

D. Delete the holidays by switching the view to the Events view.

Answer: D

19.You are working in Microsoft Outlook 2007. You compose an e-mail and mark the importance of the
e-mail to high. The Information Bar of the e-mail shows an icon that describes the e-mail has high
importance. Mark the appropriate icon that shows high importance of the e-mail.

S |
Y IE &

Answer:

S |
A N TR

- il
a3

L
a3

20.Kevin works as a Support Analyst for White Well Inc. He uses Microsoft Outlook 2007 for messaging
and e-mailing. MS Outlook has been configured to use an IMAP account. He creates a .pst file named
"Read". However the file does not appear in the Navigation Pane. He wants to ensure that the name of
the folder that is associated with the data file appears in the Folder List. Choose and reorder the required
steps he will use to accomplish the task.

Cirrect cteps Choose from here

jﬂ Click the Read pst file to open.
Click the OK button.

Click the Account Settings option.
jﬂ Click the Import and Export option.

Click on the Tools menu.

Point to Open.

Click on the File menu.

Click the Outlook Data File option.

Answer:
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L\\\,Drrect steps

Click on the File menu.
Point to Open.

Click the Read.pst file to open.
Click the OK button,

Click the Outlook Data File option.

=Kl
2

Choose from here

Click on the Tools menu.
Click the Account Settings option.
Click the Import and Export option,
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